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F1 in Schools Car Design 

Intermediate Tutorial 
 

 

 

Abstract: In this tutorial, you gain knowledge and skills in 3D modeling 

using Autodesk Inventor to design a 3D model of an F1 in Schools car from 

scratch. Learn how to assemble models to create a fully completed car, 

output a detailed engineering drawing from the model, and add dimensions, 

detail views, and cross sections. 
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Introduction 
Congratulations on choosing to work through the Autodesk Inventor F1 in Schools™ Car Design 

tutorials. Ideal for both first time F1 in Schools car designers and more seasoned car designers, 

these Autodesk Inventor tutorials are designed to get you up and running with the software 

quickly and effectively so you can have a car ready for manufacturing in record time. 

Start designing tomorrow’s fastest F1 in Schools car the fastest way now! 

 

With these tutorials, you will: 

 Get effective results faster. Use the beginner tutorials to learn the software basics. By 

simply modifying an existing car design, produce your own unique styling ready for 

manufacturing quickly and successfully. 

 Understand the F1 in Schools car body manufacturing process and improve your 

designs accordingly. Design your car body ensuring it is suitable for CNC manufacturing. 

 Save time by having access to a library of standard F1 in Schools car accessory part 

files, including the standard wheels, axle system, and tether guides. 

 Get tips for how to ensure your car body fits the dimensions of the official F1 Model 

Block. 

 Design your car so it has separate front and rear wing parts, fully integrated with the 

body design, prepared ready to export for manufacturing on a 3D printer. 

 Be reminded about F1 in Schools design regulations and how to check compliance as 

you are designing in 3D 

 Extend your skills through quick tips and exercises in our advanced tutorials. Learn 

wheel design and other features, such as design mass calculation, designing in 3D from 

a hand sketch, and CAM using Autodesk solutions. 

 Use our new Autodesk Flow Design tutorial to analyze the aerodynamic performance of 

your design in 3D, and make tweaks during your design development stages.  

 Be guided in the use of Autodesk Showcase to create stunning photorealistic renders of 

your final car assembly. 

Tutorial Work Flow: 

 

 

 

 

 

 

  

BEGINNER 

 

Learn the basics 

through creating the 

F1® Model Block. 

Then, be guided 

through how to 

create your own car 

design by modifying 

our standard F1 in 

Schools car using 

Autodesk software. 

 

 

INTERMEDIATE 

 

Discover how to 

use both parametric 

and freeform tools 

to create an F1 in 

Schools car body 

and wings from 

scratch. 

Use our standard 

wheel parts to 

complete the 

assembly. 

 

ADVANCED 

 

Realize even more 

potential through 

short exercises that 

provide you higher 

levels of design 

freedom on all car 

components, 

analysis and even 

use of our CAM 

solutions for CNC 

simulation and 

output. 
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Getting Started with Autodesk Inventor 
Autodesk Inventor is an application for creating 3D digital prototypes used in the design, 

visualization, and simulation of products. As a student or educator, you can obtain the Autodesk 

Inventor software at www.autodesk.com/education. 

Starting Autodesk Inventor 
To review the Autodesk Inventor user interface, refer to the Beginner tutorial or click on the 

following link: 

Autodesk Inventor 2016 Tutorial User Interface 

Datasets 

All project files that are required for the tutorial are provided in a dataset .zip file. Download the 

dataset file and extract the files to your computer. Do not modify the file structure of the dataset 

files. 

Video Tutorials 

Download the video tutorials supporting this tutorial. The video tutorials offer the same step-by-

step software instruction for learners that prefer guidance through video format. 

 

F1 in Schools Rules and Technical Regulations 

 
It is extremely important that you design your car to comply with the current F1 in Schools rules 
and regulations. Each country has slightly different specifications that may change from year to 
year. It is critical that you download and review your country’s F1 in Schools Rules and 
Regulations documentation and design your car to the outlined specifications. Activities in this 
tutorial leverage F1 in Schools rules and regulations for 2015-2016 and may not apply to your 
country.  
 
Important: Confirm the F1 in Schools rules and regulations for your country and competition 
before getting started. Go to your local F1 website and download the F1 in Schools rules and 
regulations documentation http://www.f1inschools.com/international-sites/.  
 

Activity 1: Model the F1 Model Block 
In this section of the tutorial you learn the basics of Autodesk Inventor by modeling the F1 
Model Block. For video instructional support, download the step-by-step video tutorials for this 
activity. 
 

  

http://www.autodesk.com/education
https://knowledge.autodesk.com/support/inventor-products/learn-explore/caas/video/youtube/watch-v-HDP761zBKJo.html?v=2016
http://www.f1inschools.com/international-sites/
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Step 1: Create a New Part File 

Designers typically work on multiple projects. In Autodesk Inventor you use project files to 

organize and access all files associated with a particular design job. A project file named F1 in 

Schools_Beginner.ipj is provided for this tutorial. 

1. Start Autodesk Inventor. 

2. On the Launch panel, click Projects. 

 
 

3. On the Projects dialog box, click Browse. 

 
4. Navigate to the location of the project file. Select F1 in Schools_Beginner then click 

Open. 
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5. Review the Projects dialog box. The active project is indicated with a check mark. 

 
6. Click Done. 

 

7. On the Launch panel, click New. 

 
 

8. On the Create New File dialog box, under Templates, select Metric. 
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9. Under Part, select Standard (mm).ipt. 

 
Note: A part file has an IPT file extension. This type of file contains a single part. 

 

10. Click Create. 

Note: F1 in Schools is an international event and uses the metric system for all engineering 

requirements. 

Step 2: Sketch the Profile of the F1 Block 

The first step in modeling the F1 block is to review the dimensions of the official F1 Model Block 

as stated in the technical regulations. This is the block of medium density modeling foam that all 

F1 in Schools car bodies are CNC machined from.  
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To model the F1 Model Block, create a sketch to define the feature profile. For this block you 

will start by creating a rectangle. The rectangle dimension as stated in the technical regulations 

is 223 x 65. 

 

Tip: Before starting this activity, review the video on the ViewCube and how to use the 

ViewCube to view your design. 

Ctrl+Click on the following link: 

Autodesk Inventor 2016 Tutorial: View Navigation 

1. On the Sketch panel, click Start 2D Sketch. 

 
 

2. Select the XZ Plane. 

 
  

Select this plane 

http://help.autodesk.com/view/INVNTOR/2016/ENU/?guid=GUID-5768486B-CB87-4277-98D6-DA832600A1C9
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3. On the Create panel, click Rectangle. 

 
 

4. Click on the origin of the sketch. 

 
5. Drag the cursor down and to the right. 

 
  

Click here 
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6. Enter 65. 

 
7. Press Tab then enter 223. 

8. Press Enter then right-click and select OK. 

9. On the ViewCube, click Top. 

 
 

10. Review the rectangular sketch. The length is 223 and width is 65. 

 
  

Enter 65 here 
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11. On the Exit panel, click Finish Sketch. 

 
 

12. On the ViewCube, click the corner as shown. 
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13. Review the browser. The sketch is added to the part history. 

 
 

14. On the Quick Access Toolbar, click Save. 

 
15. Save the file as my_f1 Model Block. 

Step 3: Create the F1 Model Block 

The height of the block as stated in the technical regulations is 50 mm. 

1. On the Create panel, click Extrude. 
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2. For Distance, enter 50. 

 
 

3. Click OK. 

 

 
  

Enter 50 here 
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4. On the ViewCube, right-click and select Set Current View as Home > Fit to View. 

 
5. On the ViewCube, click Home. 

 

Step 4: Create the Cartridge Chamber 

The dimensions for the cartridge chamber are documented in the technical regulations as 

shown. 
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1. On the ViewCube, click the top-right corner. 

 
2. On the Sketch panel, click Start 2D Sketch. 

 
3. Select the end face of the Model Block. 

 

Select this 

face 
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4. On the Create panel, click Circle. 

 
5. Click on the face to set the center point, then drag to preview the circle radius. 

 
6. Right-click, then select Diameter. 
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7. Enter 19. 

 
8. Press Enter then right-click and select OK. 

 
9. On the Constrain panel, click Dimension. When you add a dimension to a sketch it 

defines the size and location of geometry in the sketch. 
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10. Click the center point on the circle (1) then the bottom edge (2). 

 
11. Drag the dimension to the right then click to place the dimension 

 
12. Enter 29 then click OK (the check mark). Note the size of the circle changes accordingly. 

 

Click 1 

Click 2 
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13. Click the center of the circle and the right edge, then drag the dimension below the block 

and click to place the dimension. 

 
14. Enter 65/2 then click OK. This centers the hole about the 65mm width of the block. 

 
15. On the ViewCube, click the top left corner. 
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Note: To extrude the cartridge chamber you use a keyboard short to start the extrude 

tool. 

 

16. Press E. 

17. Select inside the circle. 

 
18. For Distance, enter 52. 

 
  

Select here 
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19. From the Operation list, select Cut. 

 
20. Click OK. 

 
  

Click the arrow 

to view the list 
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21. On the Navigation toolbar, from the list, click Shaded with Hidden Edges. 

 
22. Press and hold the F4 key. Hold down the mouse button then drag to rotate your model. 

Note: Review other view options on the navigation toolbar such as Wireframe with  

           Hidden Edges 

 

23. On the Navigation toolbar, from the list, click Shaded. 

24. Press F6 to return to the Home view. 

Step 5: Create the Tether Line Slot 

1. On the Sketch panel, click Start 2D Sketch. 

 
  

Click the arrow 

to view the list 
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2. Select the end face of the Model Block. 

 
Note: The sketch for the tether line slot can be created on either end of the Model Block.  

 

3. On the Create panel, click Rectangle. 

 
4. Click on the face, then drag up and to the right. 

 
  

Select this face 

Click here 

Drag cursor to 

here 
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5. Enter 6, then press Tab and enter 6. Press Enter, right-click, and then click OK. 

 
6. On the Constraints panel, click Vertical. 

 
7. Click the midpoint on the upper edge on the rectangle. 

 
  

Click here 
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8. Click the midpoint of the lower edge of the block. It is indicated by a large dot. 

 
9. On the Constrain panel, click Colinear. 

 
 

10. Click the bottom edge of the rectangle (1) then the bottom edge of the block (2). 

 
  

Click here 

Click 1 

Click 2 
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The rectangle is now dimensioned and located as stated in the technical regulations. 

 
11. Press E. 

12. On the Extents list, select To next face/body. 

 

 
  

Click the arrow 

to view the list 
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13. Click OK. 

14. Press and hold the F4 key. Hold down the mouse button then drag to rotate your model 

to view the tether slot and cartridge chamber. 

 
15. Press F6 to return to the Home view. 

16. Save the file as my_f1 Model Block. 

Step 6: Design for Manufacturing Considerations 

It is very important to have a basic understanding of how the car body will be manufactured in 

order to create s successful design. In industry, all products are designed with consideration 

given to any limitations that may exist due to the available or chosen manufacturing methods. 

An F1 in Schools car is no different. It is important to understand the manufacturing technology 

and process requirements so that the car designer can create a car body shape that is actually 

possible for a CNC machining process to manufacture. 

 

CNC (Computer Numeric Control) machining is a very important and widely used manufacturing 

method in industry. This is why it is compulsory for F1 in Schools teams to manufacture their car 

bodies using a CNC machine. Many schools are equipped with 3 axis CNC machines—the 

minimum requirement for car body manufacture. High speed 3 Axis CNC Routers are ideal for 

making F1 in Schools car bodies. Autodesk F1 in Schools tutorials support manufacturing via a 

Denford 3 Axis CNC Router. 

 

The recommended standard CNC machining method is to machine car bodies using two 

machining operations: one operation from the left side of the car and one from the right side. For 

each operation, the F1 Model Block is mounted on its side in the CNC machine via clamping in 

the special F1 in Schools Machining Fixture. This method provides for a wide range of car 

profile designs to be machined with a minimum amount of machining operations. The picture 

below illustrates this. 
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The green arrows above indicate the 3-axis direction system of the CNC machine. These are 

the 3 axes of direction that the cutting tool moves in, often simultaneously, in order to remove 

the excess Model Block material revealing the profile of your F1 in Schools racer.  

 

The standard method of manufacture is to machine the car body using two machining 

operations, one machining operation on each side of the car. The right side of the car is 

machined with the Model Block mounted as pictured above, the Model Block is then rotated 180 

degrees about the x axis to machine the left side of the car body. The left side machining 

operation is simply a mirror image of the right side. 

 

Due to there being only 3 axes or directions of movement that the cutting tool can move in, 

some shapes or profiles may not be possible to machine. The diagrams below help explain this 

further 

 

 

 

 

 

 

 

 

 

 

 

 

 

+Z 

+Y 

+X 

¼ inch / 6.35mm 

diameter ball 

nose cutting tool 

Fixture 

F1 Model 

Block 

The Model Block (green) and 

car profile (blue) are shown 

oriented on their side in the 

CNC machine. The dark blue 

circle is the CO2 canister hole 

in the Model Block. 

The cutting tool (shown in 

grey) can remove all of the 

material to produce the design 

(shown in blue) as it can be 

reached from left and right 

sides of the car. 

The material shaded in red 

cannot be removed as the tool 

cannot reach this area from the 

left and right sides. 
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As pictured on the right, it is possible to mount the Model 

Block in the CNC Router orientated to allow for machining 

from the car body top. This can then also be inverted to 

allow for machining of the car body bottom if required. 

These would be additional machining processes increasing 

complexity, time, and cost to machine the design. Note that, 

with this design, there are still areas (shown in red) that the 

cutter cannot access; these areas are not possible to 

machine using any orientation. 

 

Finally, the size and shape of the cutting tool needs to be 

considered. The standard machining process for F1 in 

Schools car bodies uses a ¼ inch (6.35mm) diameter ball 

nose shaped cutter. Looking at the diagram above you will 

notice that a small radius/fillet of material (in red) remains 

where two edges meet at an internal sharp corner. This is 

due to the ball nose shape of the cutter tip. 

 

The example to the right is a similar body profile to the 

above example. However, here the slot on the left and 

right sides of the CO2 canister housing is not as wide. The 

slot is narrower than ¼ inch/6.35mm and therefore the 

cutter cannot access and remove the material in red. Any 

slot or groove features that are narrower than the diameter 

of the cutter cannot be machined. 

 

Hopefully now you have a better understanding of the CNC 

machining process used to manufacture F1 in Schools car 

bodies and the few limitations that this imposes. You should 

now keep these factors in mind as you unleash your 

creativity in designing your F1 in Schools racecar bodies. 

  

ABOVE: Material remains in the 

sharp internal corners (shown in 

red) due to the ball nose shape of 

the cutter tip (shown in grey). 

Model Block material that will be 

machined away is indicated in 

green 
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Activity 2: Adding Axle Holes and Cutting the Block 
In this activity, you add axle holes for your wheels and modify the block to allow room for the 
wheels. You will use your F1 in Schools block created in the Beginner tutorial or in the previous 
activity. For video instructional support, download the step-by-step video tutorials for this 
activity. 
 

Step 1: Modifying the Block Length 

1. Open your Model Block. 

 
2. On the Application menu, click Save As > Save Copy As. 

3. For File name, enter a new name for your block. In this example _V1 was added to the 

original filename. The new file is a backup should you need another Model Block. 

 
 

4. On the Navigation toolbar, from the list, click Shaded with Hidden Edges. 
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Note: The supplied F1 in Schools Block is 223mm in length. The F1 Technical 

Regulations state the overall car length must be a maximum of 210mm only. Also, this is 

the maximum size the CNC router can cut due to clamping of the block in the machining 

fixture. 

5. In the graphics window, select the top face as shown, then click Edit Sketch. 

 
  



33 | P a g e  

 

 

6. Double-click the 233 dimension, then enter 210. 

 
7. Click OK (the check mark). The size of the model changes accordingly. 

8. On the Exit menu, click Finish Sketch. 
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Step 2: Creating the Axle Holes 

To create a hole, you add points to the sketch. These points are the center of the hole features. 

1. On the Sketch panel, click Start 2D Sketch. 

 
 

2. Select the front face of the block as shown. 

 
3. On the ViewCube, click Left. 
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4. On the Create panel, click Point. 

 
5. Click on the sketch twice to place the points. 

 
6. On the Constrain panel, click Dimension. 

 
  

Click 2 Click 1 
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7. Click the point on the left (1), then click the bottom edge of the block (2). 

 
 

8. Drag the dimension to the left, then click to place the dimension 

 
9. Enter 10, then click OK. 

 
10. For the second dimension, click the point then click the left edge of the block. 

11. Drag the dimension down then click to place the dimension. 

  

Click 1 

Click 2 
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12. Enter 40 then click OK. 

 
13. Repeat this workflow to add the dimensions for the point on the right of the block. The 

dimensions for the right side are 10mm and 60mm. 

 
14. On the ViewCube, click Home. 

15. Press H. This is the shortcut key for the Hole tool. 

 

16. For Diameter, enter 4. 
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17. Under Termination, the default setting Through All should be displayed. 

 
18. Click OK. The 2 holes are created. 
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Step 3: Creating the Wheel Openings 

To create space for the wheels you subtract material from the block. To do that you create 

sketches then cut the material using the extrude tool. 

1. On the Sketch panel, click Start 2D Sketch. 

 
 

2. Select the top face of the block as shown. 

 
 

3. On the ViewCube, click Top then click the arrow to rotate the block. 
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4.  

 

 
4. On the Create panel, click Rectangle. 
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5. Click on the top left edge of the face above the hole then drag down and to the right. 

 
 

6. Enter 19 then press Tab and enter 40. Press Enter, right-click, and then click OK. 

 
7. Draw a second rectangle 19mm x 98mm starting at the top right corner of the sketch. 

 
  

Click here 

Drag cursor to 

here 

Start point of 

rectangle 
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8. On the Constrain panel, click Dimension. 

 
9. Add a 20mm dimension to the first rectangle as shown. 

 
10. Press E. 

 

11. Select the 2 profiles as shown. 
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12. From the Operation list, select Cut. 

 
13. On the Extents list, select To next face/body. 

 
  

Click the arrow 

to view the list 
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14. Click OK. 

 
15. On the Work Features panel, click Plane. 

 
16. Select the front face of the block. 
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17. On the ViewCube, click the top right corner. 

 
18. Select the face as shown. The work plane is created through the center of the block. 

 
19. On the ViewCube, click Home. 
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20. On the Pattern panel, click Mirror. 

 
21. Select the extruded feature as shown. 

 
22. In the Mirror dialog box, click Mirror Plane then select the work plane. 
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23. Click OK. 

 
24. In the graphics window, right-click the work plane, then click Visibility. 

 

 
25. Save the file. 
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Activity 3: Model the F1 in Schools Car Body Shape 
In this section of the tutorial, you will modify the body, and then model the front and rear wing 

parts for your F1 car design. Throughout the process, refer to the technical regulations to check 

Regulation compliance. For video instructional support, download the step-by-step video 

tutorials for this activity. 

Step 1: Create Freeform Plane 

To modify the block, create a freeform plane on the top face of the block. The plane can be 

modified using the edit form tool to quickly create shapes that are more visually compelling. 

1. The F1 Model Block from the previous activity should be open. 

 
2. On the Sketch panel, click Start 2D Sketch. 
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3. Click the top face as shown. 

 
4. On the ViewCube, click Top. 

5. On the Create panel, click Point. 
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6. Click on the top face near the center of the block. 

 
7. On the Constrain panel, click Vertical. 

 
  

Place point 

here 
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8. Click the point (1) then click the midpoint (2) on the top edge of the block. Make sure you 

select the midpoint, not the endpoints of the tether slot. 

 
9. On the Constrain panel, click Dimension. 

10. Add a 105 dimension between the point and the top edge of the block. 

 
11. On the Exit menu, click Finish Sketch. 

12. On the ViewCube, click Home. 

  

Click 2 

Click 1 
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13. On the Freeform panel, from the list, click Plane. 

 
14. Click the top surface of the block. 

 

15. For the center of the plane, click the point created in the previous steps. 

 
16. In the Plane dialog box, enter the following values; 

a. For Length, enter 65 then for Faces enter 4. 

b. For Width, enter 210 then for Faces enter 6. 
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c. Select Length Symmetry. 

 
17. Click OK. 6 x 4 faces give us enough control over the geometry without being too dense.  

18. In the browser, right-click the sketch above the Form entry, then click Visibility. 

 

Step 2: Edit the Freeform Plane 

The edit form tool allows you to directly manipulate and modify a freeform shape. In this 

example, you select faces then drag the manipulators to create an aerodynamic shape for your 

F1 car. 
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1. On the Edit panel, click Edit Form. 

 
2. Click the 6 faces as shown. To make multiple selections, press Shift while selecting. The 

6 faces on the other side of the symmetry line are also selected. 

 
  

Select these 

6 faces 
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3. Drag the manipulator down then enter -10. Do not click OK. 

 
4. Click the 4 faces as shown then drag the manipulator down -10. 

 
5. Click the 2 faces as shown then drag the manipulator down -10. 

 

Drag this 

manipulator 

down 

Select these 

4 faces 
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6. Click OK. 

 
7. Double-click the 2 edges as shown. The complete edges should be selected. To make 

multiple selections, press Shift while selecting. 

 
8. Click Edit Form then drag the manipulator down -10. 

 
  

Select these 

2 edges 
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9. Select the outside edge only then drag the manipulator down -20. 

 
 

10. Click OK. 

 
11. On the Edit panel, click Edit Form. 
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12. Double-click the outside edge, then hold down the Alt key and drag the manipulator 

down -20. Holding down Alt adds new faces to the form. 

 
13. Click OK. 

 
14. On the Edit panel, click Edit Form. 
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15. Select the 2 edges at the front of the plane as shown. 

 
 

16. Drag the manipulator into the car 25. 

 
17. Click OK. 

 

Select these 

2 edges 
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18. Select the 3 faces as shown. 

 
19. On the Modify panel, click Subdivide. 

 
20. Click OK. 

 

Select these 

3 faces 
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21. Double-click the edge as shown. The complete edge should be selected. 

 
22. On the Edit panel, click Edit Form.  

23. Drag the manipulator into the car 10mm. 

 
24. On the ViewCube, click the top left corner. 

 

Drag this 

manipulator 
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25. Review the distance between the cartridge chamber and the modification you just 
created. There must be 3.5mm of material between them per the Regulations 

 
26. Click OK. 
27. Return to the Home view. 

 
28. On the Edit panel, click Edit Form. 
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29. Double-click the same edge and drag the rotation manipulator counter-clockwise 70 

degrees. 

 
30. Click OK. 

 
  

Drag this 

manipulator 
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31. On the Exit panel, click Finish Freeform. 

 

Step 3: Split the Car Body 

The freeform plane you created will be used to remove material above the plane and create a 

dynamic design for your car. To do this, use the split tool. 

1. On the Modify menu, click Split. 

 
2. On the Split dialog box, click Trim Solid. 
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3. Select the freeform surface. An arrow is displayed indicating which side material will be 

removed from. 

 
4. Click OK. 
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5. In the browser, right-click the Form entry, then click Surface Visibility. 

 
6. Save the file. 

Activity 4: Designing the Wings 
In this activity, you will model organic shaped front and rear wings for your car body. The wings 

are created as solid bodies, which will allow you to 3D print them later. For video instructional 

support, download the step-by-step video tutorials for this activity. 

 

Step 1: Model the Rear Wing 

1. In the browser, locate the work plane created previously. Right-click the work plane then 

click Visibility. 
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2. On the Sketch panel, click Start 2D Sketch. 

 
3. Select the work plane. 

4. Zoom and pan to the left side of the car. 

 
5. On the Create panel, click Point. 
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6. Click to place a point as shown. 

 
7. On the Constrain panel, click Vertical. 

8. Click the point (1) then the center point of the bottom edge (2) as shown.  

 
  

Place point 

here 

Click 1 

Click 2 
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9. Add a dimension of 51mm between the point and the bottom edge of the block. 

 
10. On the Exit panel, click Finish Sketch. 
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11. On the Create Form panel, click Box. 

 
12. Click the work plane then click the point to specify the center of the box. 

 
13. In the Box dialog box, enter the following values; 

a. For Length, enter 18. 

b. For Width, enter 3.5. 

c. For Height, enter 60 then for Faces enter 4. 

d. Under Direction, select Both Directions. 

e. Select Height Symmetry. 
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14. Click OK. 

 
15. On the Exit panel, click Finish Freeform. 

16. In the browser, expand Solid Bodies. Note that there are 2 solid bodies, the first is the 

car body and the second is the rear wing. This will be useful for modeling the parts 

separately. 
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Step 2: Model the Front Wing 

1. In the browser, locate the sketch created previously. Right-click the sketch then click 

Visibility. 

 
2. On the ViewCube, click Left. Zoom and pan into the front of the car. 
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3. On the Create Form panel, click Box. 

4. Click the work plane. 

5. Click to specify the center of the box. The center is approximately in line with center of 

the hole and midpoint from the right edge of the block. 

 
6. In the Box dialog box, enter the following values; 

a. For Length, enter 20. 

b. For Width, enter 3. 

c. For Height, enter 65. For Faces, enter 4. 

d. Under Direction, select Both Directions. 

e. Select Height Symmetry. 

 
7. Click OK. 

8. On the ViewCube, click Home. 

Click 

here 
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9. Double-click a face on the wing. This selects the complete wing. 

10. On the Edit panel, click Edit Form. 
11. Drag the rotational manipulator 30 degrees clockwise. 

 
  

Drag this 

manipulator 
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12. Click OK. 

 
13. On the Exit panel, click Finish Freeform. 
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14. Turn off the visibility of the sketch and the work plane. 

 
15. Save your file. 

Step 3: Add the Wing Support on the Body 

The rear wing is not connected to the car body. You now create a support to connect the car 

body and the wing. 

1. In the browser, right-click Form2 then click Solid Visibility.  

Note: Your form number may be different; the rear wing should be selected. 

 
2. On the Work Features panel, click Plane. 
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3.  In the browser, expand the Origin folder then click XZ Plane. 

 
4. Click the top curved face at the rear of the car. 

 

Click this 

face 
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5. On the Sketch panel, click Start 2D Sketch. 

6. In the graphics window, click the work plane. 

7. Turn off the visibility of the work plane. 

8. Rotate the block as shown. 

 
9. Zoom and pan to the left end of the block. 

 
10. On the Create panel, click Rectangle. 
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11. Create an 8mm x 8mm rectangle. 

 
12. On the Constrain panel, click Vertical. 

Note: You are applying a vertical constraint. It appears horizontal because the block is 

rotated about the axis of the sketch plane. 
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13. Click the midpoint on the left side of the rectangle (1) and the midpoint of the left edge of 

the block (2) located between the hidden edges of the tether slot. 

 
13. On the Constrain panel, click Horizontal. 

14. Create a constraint between the midpoint of the lower edge of the rectangle (1) and the 

bottom edge of the block (2). 

 

Click 1 Click 2 

Click 1 

Click 2 
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15. Press E. 

16. For the profile, the rectangle should be automatically selected. 

 
17. In the Extrude dialog box, click Asymmetric. 

 
18. Under Extents, for distance 1 enter 5 then for distance 2 enter 3. 
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19. For Operation, select New Solid. 

 
 

20. Click OK. 

 
Note: A new solid is created so that it can be subtracted from the rear wing. The wing 

will be 3D printed so it requires a rectangular slot for assembly. 

Step 4: Add the Wing Support on the Rear Wing 

1. Turn on the visibility of Form2 (the rear wing). 
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2. On the Modify panel, click Combine. 

3. For Toolbody, select the rear wing. 

 
4. For Base, select the extruded feature Solid4. It is easier to select it from the browser. 

5. Click Keep Toolbody. 

6. Under Operation, select Cut. 

7. Click OK. 

8. Rotate the block to view the cut in the rear wing. 

 
9. In the browser, under Solid Bodies, turn on the visibility of Solid4. 

 
10. In the browser, right-click Solid4 then click Hide Others. 

11. Zoom into the extruded feature. 

12. On the Work Features panel, click Plane. 
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13. Select the top face of the body then drag it downwards. For distance, enter -1.5. Click 

OK. 

 
14. Start a new 2D Sketch on the work plane. 

15. Press F6 to return to the Home view. If required, zoom and pan to view the body. 

16. On the Create menu, click Project Geometry. 

17. Click the top face of the body. 

 
  

Click this 

face 
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18. On the Modify panel, click Offset then drag the projected sketch away from the body. 

 
19. For distance, enter 1 then press Enter. 

20. Press E. 

21. Select the profile around the body then drag the arrow on the preview to change the 

extrusion direction to down. 

 
22. For Distance, enter 1.5. 

23. Select New Solid then click OK. 
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24. Turn off the visibility of the work plane. 

 
25. In the browser, right-click Solid2 (rear wing) then click Visibility. Rotate the part to view 

the underside. 

 
26. On the Modify panel, click Combine. 

27. Repeat the previous workflow to join the rear wing Solid2 (Base) to the new extrusion 

Solid5 (Toolbody). In this workflow you are joining the bodies and not keeping the 

toolbody. 

28. In the browser, turn off the visibility of Solid4. The rear wing (Solid2) now has a hole and 

support to assist in the assembly of the car. This body will be exported as an STL file 

and 3D printed. 
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29. In the browser, right-click Solid2 then click Show All. 

30. Press F6 to return to the Home view. 

 
29. Using the same workflow as the previous steps, combine the extruded feature (Solid4) 

and the main block (Solid1). In this workflow, you are joining the bodies and not keeping 

the toolbody. 

Note: The extruded feature is joined to the main block so that fillets can be added. This 

will be done later in the tutorial. The extruded feature and the block are machined as one 

piece and the fillets allow the 6mm router to machine around this feature. 

 

31. Save the file. 
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Step 5: Split the Body to Create a Nose Cone 

As part of the car design it has been decided that the nose cone should be a separate body. To 

do this, use the split tool to create two solid bodies. 

1. On the Work Features panel, click Plane. 

2. Select the front face of the car, then, drag the plane into the car. For distance, enter -35. 

 
Note: If the front wing and the work plane interfere, you need to move the front wing 

forward. Use Edit Form to move the form (Form3 in this example) forward and away 

from the work plane as shown. 

3. On the Modify panel, click Split. 

4. In the Split dialog box, click Split Solid. 
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5. Click the work plane then click the car body 

6. Click OK. The car body is split into 2 bodies. 

 
 

7. In the browser, right-click Solid3 (front wing) then click Visibility. Repeat for Solid6 (front 

nose cone). Your numbers may be different. 
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8. Create a new 2D Sketch on the work plane. 

 
9. On the Create panel, click Rectangle. 

10. Sketch a 10mm x 4mm rectangle as shown. 

 
11. Add a 13mm dimension between the top edge of the rectangle and the bottom edge of 

the car as shown. 
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12. Add a vertical constraint to the rectangle and tether line slot to center the rectangle 

about the slot. 

13. Press E. 

14. Extrude the profile 10mm. 

 
15. Turn off the visibility of the work plane. 

16. Turn on the visibility of Solid 6 and Solid7. 

17. On the Modify panel, click Combine. 

18. Cut Solid6 (Base) from Solid7 (Toolbody), making sure to keep the Toolbody. The slot is 

created in the nose cone of the car. 

19. Review the nose cone and the slot. 
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20. Press F6 to return to the Home view and show all the bodies. 

 
21. Save the file. 

Step 6: Editing the Wing Shapes 

The wing shapes were created using a freeform box. The current shape can be modified to 

enhance its aerodynamic design. To do this, use the edit form tool. 

1. Click on the front wing then click the Edit Freeform icon. 

 
 

2. Click the face as shown. 
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3. On the Edit panel, click Edit Form. 

4. Hold down the Alt key then drag the manipulator 3mm away from the car body. 

 

 

Click 

here 

Drag this 

manipulator 
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5. Double-click the edge as shown. The complete edge around the wing should be 

selected. 

 
6. Drag the manipulator forward 4mm as shown. 

 

 
7. Click OK. 

8. On the Exit panel click Finish Freeform. 

9. Return to the Home view. 

Double-click this 

edge 

Drag this 

manipulator 
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10. Click on the rear wing, then, click the Edit Freeform icon. 

11. On the Symmetry panel, click Symmetry. 

12. Click the face as shown. 

 
 

13. Rotate the wing, then, click the face directly underneath the previous selection. 

 
A second line of symmetry is added to the rear wing. 

 

Click 

here 



96 | P a g e  

 

14. On the Modify panel, click Subdivide. Splitting the faces into smaller sections gives you 
more control over minor adjustments. 

15. Click on the top face you selected previously, then rotate the wing and subdivide the 
back face as shown. 

 
16. On the Edit panel click Edit Form. 

17. Double-click the edge as shown. 

 
18. Drag the manipulator towards the front of the car 5mm. 

 

Subdivide 

the back 

face 

Subdivide 

the top face 

Double-click 

this edge 



97 | P a g e  

 

 
19. On the Edit panel click Edit Form. 

20. Select the 2 large faces at the end of the wing, using Shift for multiple selections. 

 
21. Drag the vertical manipulator down 0.8mm. 

 

Drag this 

manipulator 
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22. Click OK. Then, on the Exit panel, click Finish Freeform. 

23. Return to the Home view. 

Activity 5: Adding Fillets to the Car 
In this activity, you add fillets (rounded edges) to your car to assist with aerodynamics and to 

make it suitable for machining. For video instructional support, download the step-by-step video 

tutorials for this activity. 

 

1. On the Modify menu, click Fillet. 

2. Select the inside edges of the wheel surrounds on both sides of the car as shown. 

 
3. For radius, enter 3. The cutting tool used to cut your car has a diameter of ¼ 

inch/6.35mm, so it will leave a radius of 3mm on any internal cut (or 3.175mm if you 
want to be precise!). 
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4. Click OK. 

 
 

5. Add 5mm fillets to the 4 edges as shown. 
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6. Add an 8mm fillet to the nose cone as shown. 

 
7. Add 3mm fillets to the edges around the extrusion as shown. 
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Activity 6: Assemble the F1 in Schools Car 
In this activity, you assemble the components that make up the complete car. You then check to 

make sure your Car Body design fits within the block. For video instructional support, download 

the step-by-step video tutorials for this activity. 

 

Step 1: Start a New Assembly File 

1. On the Application menu, click New. 

2. Under Templates, click Metric. 

3. Under Assembly, click Standard (mm). 

 
4. Click Create. 

5. Save the file as my F1 in Schools Car Assembly. 

6. On the Component panel, click Place.  

 
7. In the Place Components dialog box, select Inventor F1 in Schools Body then click 

Open. The selected component is placed in the graphics window attached to the cursor. 
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8. In the graphics window, right-click, then click Place Grounded at Origin. 

 
9. Right-click, then click OK. You now set a different Home view. 
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10. Rotate the car body approximately as shown. 

 
11. On the ViewCube, click the front corner as shown. 

 
12. On the ViewCube, right-click, then click Set Current View as Home > Fit to View. 
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13. Press F6 to return to the Home view. 

 

Step 2: Place the Straws in the Assembly 

1. On the Component panel, click Place. 

2. In the Place Components dialog box, select Inventor F1 in Schools Straw_Rear then 

click Open. 

3. Click to place the straw then right-click and click OK. 

 
Note: The straw should be flush to the sides of the body at the rear and front of the car. 

You measure the distance to determine the length for each straw. 
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4. In the graphics window, right-click, then click Measure. 

 
 

5. Select the front face of the wheel opening, then rotate the car body and select the 

opposite face. 
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6. Review the Measure dialog box. The distance is 27mm. 

 
7. Right-click, then click OK. Return to the Home view. 

8. In the graphics window, right-click the straw then click Edit. 

9. Click the straw then click Edit Extrude. 

 
10. For distance, enter 27 then click OK. 

11. On the Return panel, click Return. 
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Note: There are 3 options for assembling the parts: Joint, Constrain and Assemble. In 

this tutorial, the focus is on Joint and Constrain. As each workflow is used, you can 

better determine when to use which tool. 

 
12. On the Relationships panel, click Constrain. 

13. In the Place Constraint dialog box, click Insert. 
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14. Select the outside edge of the straw as shown. 

 
 

15. On the car body, select the edge of the hole. 

 
16. In the Dialog box, click Aligned. 

 
17. Click OK. 
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18. On the View tab > Visibility panel, click Degrees of Freedom. Note that the straw has 

one degree of freedom: rotational about the X-axis. 

 

 
Note: The straw should have no degrees of freedom. The easiest workflow is to ground 

the part now that it is in the correct position. 

19. In the browser, right-click the straw, then click Grounded. The degrees of freedom icon is 

no longer displayed. 
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20. On the View tab > Visibility panel, click Degrees of Freedom to turn off the display. 

21. Repeat the workflow to place, measure, and edit the Inventor F1 in Schools Straw_Front 

part. 

Note: The curved surface around the hole at the front of the car means you cannot use 

the insert constraint. You will use the Joint tool. 

22. On the Relationships panel, click Joint. 

23. Move the cursor over the straw, then click when the center is highlighted as shown. 
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24. Move the cursor over the hole in the car body; click when the center is highlighted as 

shown. 

 
25. From the joints type list, select Rigid. This will remove all degrees of freedom. 

 
26. Click OK. 

 
27. Save the file. 
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Step 3: Place the Axles in the Assembly 

1. Place two Inventor F1 in Schools Axle parts in the assembly. 

 
2. On the Relationships panel, click Joint. 

3. Using the workflow from the previous section, add a rigid joint between an axle and the 

hole at the front of the car. 

 
4. On the Relationships panel, click Joint. 

5. Select the center of the axle. 
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6. Right-click, then click Between Two Faces. 

 
7. Select the front face of the block beside the hole. Then, select the opposite face. 
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8. For the origin, select the edge as shown. 

 
9. Click OK. 

10. Return to the Home view and click Top. Review the assembly to make sure the axles are 

centered. 

 
11. Return to the Home view. 
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12. Place four Inventor F1 in Schools Washer parts in the assembly. 

 
13. On the Relationship panel, click Constrain. Use the Insert type to assemble the four 

washers. The rear washers can be flush to the car body, but the front washers should 

have a 0.5mm offset to prevent any interference with the curved surface of the car body. 
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14. Place four Inventor F1 in Schools Wheel parts in the assembly. 

 
15. On the Navigation toolbar, from the list, check that Shaded with Edges is selected. This 

will make it easier to select the edges on the black wheels. 
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16. On the Position panel, click Free Rotate. 

 
17. Select the rear wheel and rotate as shown. This will make it easier to select the correct 

edges. 
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18. On the Relationship panel, click Constrain. Use the Insert type to align the wheel to the 

axle. Select the edge on the wheel then the edge on the washer and use an offset of 

1.5mm. 

 

 
19. Click OK. 

 

Edge on 

wheel 

Edge on 

washer 
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20. Repeat this workflow for the other three wheels. 

 
Note: The wheel is free to rotate around the axle. In the following steps you assemble 

the hubcap to the wheel using a rigid joint so that the wheel and hubcap rotate together. 

21. Place four Inventor F1 in Schools Hubcap parts in the assembly. 

 
22. Use Free Rotate to align the hubcap as shown. 
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23. On the Relationship panel, click Joint. Use a Rigid joint type to align the hubcap origin to 

the wheel origin. 

 

 
  

Click on 

front face of 

hub cap 

Click on 

inside face 

of hub cap 
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24. Click OK. Click and drag on the wheel to check that the wheel and hubcap rotate 

together. 

 
25. Repeat this workflow for the other three hub caps. 

 
26. Right-click the car body then click Open. 
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27. Start a new 2D sketch on the horizontal face of the tether guide slot, then create 2 points 

on the sketch as shown. 

 
28. Constrain the points to the middle of the tether guide slot. Depending on the position of 

the car body, this will be a vertical or horizontal constraint. 

 
 

29. Add dimensions to position the points according to the regulations—which states that the 

front guide must be in front of the front axle and the rear guide behind the rear axle. 

 
30. Press H to start the Hole tool, then place two holes 0.75mm diameter and 5mm deep. 

31. Press OK, then return to the Home view. 

32. Save the file. 

33. Return to the assembly file. 
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34. On the Relationship panel, click Constrain. Use the Insert type to insert the guides into 

the drilled holes. For the selection on the guide, use the thread edge closest to the 

circular end of the tether. 

 
35. If required, rotate the guides to align with the slot. 

36. Place an Inventor F1 in Schools Hub CO2 Cartridge part in the assembly. 

37. On the Relationship panel, click Constrain. Use the Mate type to align the center line of 

the cartridge and the chamber. 

 
  

Select this 

edge 
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38. Drag the cartridge out of the chamber, then use a tangent constraint to align the rounded 

end of the cartridge with the flat end of the chamber. 

 

 
39. Save the file. 
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Activity 7: Check for Regulation Compliance 
In this activity, you check if your design complies with some of the F1 in Schools Regulations. It 

is vital to make sure your car is legal. There are some critical Regulations that it has to comply 

with, and some non-critical Regulations will just cause you to lose points on if your car does not 

comply. For video instructional support, download the step-by-step video tutorials for this 

activity. 

Step 1: Review the Regulations 

1. The current F1 in Schools Technical Regulations can be found on your in-country F1 in 
Schools website. For a list of in-country websites visit - 
http://www.f1inschools.com/international-sites/  

2. Those highlighted in yellow are critical technical regulations and must be followed or 
your car will not be eligible. 

  

http://www.f1inschools.com/international-sites/
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Step 2: Check the Model for Regulation Compliance 

1. The assembly of your F1 in Schools car should be open. 

 
2. On the Sketch tab > Sketch panel, click Start 2D Sketch. 
3. In the browser, expand the Origin folder then click YZ Plane. 
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4. On the ViewCube, click Left. 

 
5. On the Create panel, click Rectangle. 
6. At the bottom right corner of the car block, click to start the rectangle. This is the origin of 

the model. 

 
7. Drag to the left and upwards to start the rectangle. 
8. Enter 50, press Tab, then enter 210. Press Enter, then click OK. 

 
9. Review the sketch and the car body only. Does it fit within the rectangle? The regulation 

requires that the car cannot be longer than 210mm and this design complies with the 
regulation. 

10. On the Exit panel, click Finish Sketch. 
11. In the browser, right-click the sketch, then click Visibility. 
12. On the Sketch tab > Sketch panel, click Start 2D Sketch. 
13. In the browser, expand the Origin folder, then click YZ Plane. 
14. Sketch a rectangle behind the front wheel arch as shown. 
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Note: The Regulations state that there must be a 15mm exclusion zone behind the front 
wheels. 

15. Add a horizontal dimension to the sketch. The dimension exceeds 15mm, so the current 
design complies with the regulations. 

 
16. On the Exit panel, click Finish Sketch. 
17. Continue using this technique to check all the Regulations listed. If your car does not 

comply, you can double click the feature in the history to edit. 

Activity 8: Create Detailed Drawings of Your F1 Car 
In this activity, you will create orthographic drawings and add section views, detailed 

dimensioning, and exploded views. For video instructional support, download the step-by-step 

video tutorials for this activity. 

 

Our tutorial serves to provide you with an overview of the different Fusion 360 technical drawing 

tools and capabilities. F1 in Schools Competition Regulations stipulate that you should produce 

a 3rd Angle Projection Orthographic drawing. We recommend that you research the 

requirements of this specific Engineering Drawing standard before finalizing the Orthographic 

drawing to be included with your submission. 
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Step 1: Create a New Drawing File 

1. On the Application menu, click New. 

 
2. On the Create New File dialog box, under Templates, select Metric. 

 
  

Click the arrow 

to view the list 
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3. Under Drawing, select ISO.idw. 

 
4. Click Create. 

5. Save the file as my_F1 in Schools Car Assembly. 

6. In the browser, right-click Sheet:1 then select Edit Sheet. 

7. Review the sheet size. It is an A3 (420mm x 297mm). 

8. For Name, enter Car Assembly. 

 
9. Click OK. 

Step 2: Create Orthographic Views 

1. On the Create panel, click Base. 
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2. On the ViewCube, click the arrow on the left. The drawing preview changes. 

 

 
3. Drag the preview to the top left corner. 
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4. Move the cursor down then click to place a projected view. 

 
5. Repeat this process to place 2 more views as shown. 
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6. In the Drawing View dialog box, click OK. 4 views of the car body are created at a scale 

of 1:2. 

 
7. Right-click the pictorial view then click Edit View. 

 
8. In the Drawing View dialog box, under Style, click Shaded then click OK. 
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10. On the Create panel, click Projected. 
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11. Click and drag the front view to create another pictorial view as shown. 

 
12. Drag the pictorial views to arrange them on the sheet as shown. Then, change the style 

of the new pictorial to shaded. 

Note – what is shown in this tutorial is purely representative of what can be achieved. You 
will need to research the ISO drawing layout standard for 3rd Angle Orthographic Technical 
Drawings so that you can ensure your drawings comply with this standard 
 

 
13. Save the file. 
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Step 3: Adding Dimensions 

As mentioned earlier, you should research the relevant drawing standards to learn more about 

how dimensions and other text should be properly placed on your drawing relative to the views 

and parts. 

 

1. On the Annotate tab > Dimension panel, click Dimension. 

 
2. Click point 1 and 2 as shown, then drag the dimension away from the view until a dotted 

line is displayed. Click to place the dimension. 

 
  

Point 2 Point 1 
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3. Repeat this process for 2 more dimensions. When the dimensions are placed, right click 

then click OK. 

 
Note: The dimensions are displayed with a precision of 2 decimal places. You will 

change the dimension style to display zero decimal places. 

4. On the Manage tab > Styles and Standards tab, click Styles Editor. 

 
5. In the left panel, expand Dimension, then click Default (ISO). 
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6. On the Units tab, under Linear, select 0 from the Precision list. 

 
7. Click Save then click Done. The dimensions are updated to the new style setting. 

Step 4: Create Section Views 

1. On the Place View tab > Create panel, click Section. 

2. Click on the plan view, then click 2 points to the left of the nose cone as shown. 
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3. Drag the cursor to the right, and then right-click and click Continue. A preview of the 

view is displayed. 

 
  

Point 1 

Point 2 
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4. Right-click, then click OK. The section line and text can be dragged to new locations to 

improve the presentation of the drawing. 

 
5. Save the file. 

Step 5: Create Detail Views 

Detail views are created to show larger scale views of parts that are difficult to see or 

dimension. 

1. On the Create panel, click Detail. 

2. In the front view, click below the rear wing as shown. 

 
  

Click here 
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3. Drag the cursor to create a circle as shown. 

 
4. Click to create the view, then drag it above the front view as shown. Move the text below 

the view. 

 
5. Save the file. 

Next Steps 
Now that you have successfully designed an F1 in Schools car, you can move on to the 

advanced tutorial. This tutorial will give you tips on how to create your own car design using 

different 3D modeling techniques, how to model your own wheels, and how to analyze the 

mass of your model. 
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